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Vissim (Version 11) Module Overview 
This is the first in a series of Vissim modules. This module will guide you through the creation 
of a corridor that consists of three 4-approach intersections. The network is regulated by fixed-
time traffic signals using ring barrier control. In the second module in the series you will 
convert one intersection to actuated control, in the third you will add an unsignalized 
intersection to the model, and in the fourth you will incorporate a freeway interchange.  
 
This module will step through six main components of network creation: 

1. Defining links and connectors: the “roads and intersections” of the network. 
2. Defining traffic controllers: the signals controlling intersection traffic. 
3. Setting traffic volumes and routing decisions: settings that control the entering traffic 

volume and vehicle paths.  
4. Defining conflict zones: zones that specify right of way where vehicle movements 

conflict. 
5. Setting performance measures and creating output files. 
6. Running the model. 

Starting Vissim 
Go to Start → PTV_Vision 2018 → PTV VISSIM 11 

Note: This assumes a computer running Windows 10; start-up may be slightly different for 
other operating systems. If you receive a start-up error, you are likely having an 
installation or license issue; please contact your IT support. 

Navigating the View Screen 
Several PTV Welcome messages may appear when you start Vissim. Close these by clicking 
on the × in the upper right corner of the Start page window (see Figure 1). 
 

 
Figure 1: Vissim Start page window 

 



Toggle Background Map 

If your Vissim instance shows a map of the world in the Network Editor window, turn that 

off for now by left-clicking the Toggle Background icon  in the Network Editor ribbon 
(see Figure 2).  

Note: The Network Editor layout should now be gray. 

 

 
Figure 2: Network Editor icon ribbon 

Link Display Setting 

Vissim has two display settings: normal display (default) or centerline display. The default 
display shows each link (roadway segment) as a full-width roadway. This module is shown 
in the centerline display, which shows each link as just the centerline. You may toggle 
between these display modes by pressing Ctrl-A on the keyboard or clicking the Toggle 

Wireframe icon  in the Network Editor ribbon.  

Note: Toggling this mode now will not produce any changes, as we have not yet created 
any network sections.  

Zoom 

To zoom in and out on the View screen, use the Zoom icons  in the Network Editor 
ribbon. To use these, click the left button (magnifying glass with the +) and draw a box 
around the area in which you want to zoom in closer, or click the right button (magnifying 
glass with the −) to zoom out.  

Note: Depending on your setup, you may also be able to zoom in and out with the mouse 
wheel. 

Pan 

Click the Shift icon  to enable the ability to pan the map using them mouse. You will 
need to then deselect the Shift icon to use the mouse for other purposes in the Network 
Editor window.  

Note: Depending on your setup, panning may also be done by holding down the mouse 
wheel and moving the mouse in the desired direction.  



Units 

The default Vissim units are metric. To change to imperial: 
 

step i. Left-click on Base Data → Network Settings → Units. 
step ii. Left-click All Imperial. 
step iii. Left-click OK. 

Save 

Save the file before you start building the module: 
 

step i. Left-click File → Save as. 
step ii. Name the file “Module 1” and select the directory where you wish to save 

your work. 
step iii. Select OK. 
 

 
IMPORTANT: SAVE FREQUENTLY AS YOU WORK! 

  



Building the Model, Part 1: Links and Connectors 
 

Introduction 

The basic element of a Vissim network is called a link. A link represents a single direction 
of flow for a single- or multi-lane roadway segment. Therefore, a two-way roadway is 
modeled using two links with opposite directions of flow.  
 
For a vehicle to travel from one link to the next—for example, a mainline vehicle turning 
onto a side street—there must be a connector connecting the links. Only connected links 
allow for continuing traffic. Links that simply overlap or cross one another (without 
connectors) have no interaction with each other. Where overlapping links do not have a 
connector, vehicles will appear to “drive over” each other. Overpasses are loosely modeled 
in this way. Whereas you can add z-coordinates to the overlapping links to make the 3-D 
visualization look better, Vissim does not consider these coordinates when modeling 
interactions. Vehicles will drive over each other where links cross, even with the same 
z-coordinates, if there is not a connector and the other model features needed to reflect 
interactions.  

 
For this module, a right-click will be used to create new objects. To confirm Vissim is set 
for this behavior:  
 

step i. Left-click on Edit → User Preferences → Network Editor. 
step ii. Under Right-click behavior, left-click on creates a new object. 
step iii. Left-click OK. 

 
Links can now be created with a right-click, and the context menu is opened by pressing 
Ctrl + right-click.  

Note: Selecting that option opens the context menu would result in flipping the right-click 
behavior between the two options.  

Currently, the Network Editor map size is likely very large. You can see the current scale 
in the lower left-hand corner of the Network Editor screen. Zoom in until the total Network 
Editor window width is approximately 2000 ft. (This does not have to be too accurate, as 
it is simple to zoom in and out as needed.) 
 



Creating Links 

In this section, you will create the link layout as shown in Figure 3. 
 

 
Figure 3: Link layout in Network Editor window 

Creating East–West Main Roadway Centerline 
You will first create the east–west roadway centerline, which will extend the length of 
the three-intersection arterial. The link should be approximately 2000 ft long, allowing 
for 500 ft between intersections and at the network entry points. To create the link: 
 

step i. Left-click the Links icon  in the 
Network Objects toolbar.  
Note: This is located to the left of the Network Editor window. 

step ii. Right-click at the desired position of the link (roughly halfway down the 
Network Editor screen, near the left edge) and hold the mouse button. 

step iii. Drag the mouse in the direction of flow (in our example, do eastbound 
first, i.e., left to right) to the destination point and release the button (see 
Helpful Hints on the next page).  
Note: An exact 2000 ft is not necessary at this point, as you can adjust 

this later. 
step iv. When you reach the end of the link and release the mouse button, the Link 

Data window containing the link data will pop up (see Figure 4). 
• Set the number of lanes equal to 2. 
• Type in the roadway name (for our example, use “Buzz Blvd EB”) 

in the Name box. 



Helpful Hints 
 

While dragging the mouse, the link length is visualized by the mouse pointer.  

  
For version 11 or earlier of Vissim, the link length is visualized in the status 
bar at the bottom of the Network Editor window (Figure 2). The number on 
the right is the link length in feet, and the numbers on the left are the x and y 
length coordinates of the cursor in meters. 

 

 

• Leave the other parameters at the default values for now, but take 
a few moments to review the other possible link inputs.  

step v. Select OK to close the Link Data window. 

 

Figure 4: Link Data pop-up window 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

 



Helpful Hint 
 

Avoid the temptation to skip over naming links, adding direction labels, and 
other “optional” information. The small amount of time invested now will save 
you significant time and effort (as well as reduce the likelihood of errors) later, 
during validation, calibrations, and model updates. Also, reviewing a model 
created by another person becomes a much easier task when the model elements 
are well labeled. 

step vi. Generate a link of equal length in the opposite direction: 
• With the link selected, press Ctrl + right-click on the link, and 

click on generate opposite direction.  
• Select “2” for the number of lanes.  
• Update the Name to “Buzz Blvd WB”. 

Note: You could also draw the lane with the mouse, as described 
previously. If you choose this method, be sure to drag from right 
to left for flow in the opposite direction. 

 
Creating Cross-street Centerline Links 

Repeat the procedure for creating links to add three north–south links, located at 
approximately 500 ft, 1000 ft, and 1500 ft along the east–west roadway.  
Note: The locations do not need to be exact for the module. Use the grid in the 

background to estimate these locations. 
• Make all north–south links approximately 1000 ft. 
• Set the number of lanes to “1” for all north–south links. 
• Name the westmost roadway “Burdell Dr”, the center roadway “Ramblin St”, 

and the eastmost roadway “Pi Pkwy”. Include the direction in your naming 
convention, i.e., “Burdell Dr NB” and “Burdell Dr SB”. 

 
 

 
 
 
 
 
 
 
 
 
 

Creating Left-turn Bays 
Next you will add turn bays for the center intersection (i.e., intersection of Buzz Blvd. 
and Ramblin St.):  
 

step i. Create turning pockets in the middle intersection by drawing two short 
links (approximately 150 ft) using the same method as above. To create 
these links: 



• Draw turning pockets in between the through lane and in the 
direction of flow. 

• Make room for the turning pockets by moving apart the horizontal 
centerline links of Buzz Blvd. The distance between the 
centerlines should be approximately 50 ft. 

• To move a created link, left-click on the link and drag it to the 
desired position. 

• Do not drag the turn-bay links all the way to the middle of the 
intersection, as you still need to add connectors. There should be 
approximately 75 ft to 100 ft between the turn-bay links.  
Note: This is a rough estimate; you can fine-tune the locations 

as you add the connectors in the next section. 
• Make each turn bay 1-lane. Be sure to include link names, i.e., 

“Buzz Blvd WB LT bay” and “Buzz Blvd EB LT bay”. 
• You may also wish to space the cross-street links at all three 

intersections approximately 25 ft apart. While this will not 
influence the operation of the model, the graphic will look better. 

 

The network layout should be similar to that in Figure 5. 
 

 
Figure 5: Network link layout with left-turn bays 

Creating Connectors 

Connectors are used to connect links, allowing vehicle flow from one link to the next. In 
this module they are used to: 

• Enable the turning movements connecting Buzz Blvd. and the cross streets. 
• Allow cars to travel from the Buzz Blvd. through lanes to the turn bays. 



In this module, we will assume left-turn, through, and right-turn movements are allowed 
for all approaches of the three intersections, with EB and WB left-turn bays at the 
intersection of Buzz Blvd. and Ramblin St. However, if a movement is not allowed at an 
intersection, you may exclude the connector—with the exception that if you wish to 
prohibit a movement at certain times but not others (e.g., peak hour left-turn prohibition), 
then the connector for that movement must be included in the model. In that case, other 
methods are utilized to restrict traffic based on time of day or vehicle type. 
 
Creating Buzz Blvd. / Burdell Dr. Intersection Connectors 

Start by adding a connector at the westmost intersection, i.e., Buzz Blvd. and Burdell 
Dr.  
Note: You may find it helpful to position this intersection in the center of your screen 

and zoom in.  
Add the connector for the EB movement left-turn lane, from the east–west roadway to 
the cross street as follows: 
 

step i. Right-click with the mouse at the desired start position of a left-turn 
movement on the inside lane of the Buzz Blvd. EB link (leftmost lane on 
the eastbound link).  
Note: Connectors are lane-specific and you must ensure you select the 

desired lane on a given link.  
step ii. Drag the mouse in the direction of flow to the position on the receiving 

link where the vehicle will merge with the link. 
step iii. Release the mouse button. Upon releasing the button, the Connector edit 

window will pop up. 
step iv. Name the connector “Buzz Blvd EB to Burdell Dr NB – LT”. 
step v. Check the from link and to link boxes to make sure you have correctly 

placed the connector: 
• Lane 1 is always the closest to the edge of the road (i.e., lanes are 

numbered from the curb to centerline). 
• Thus, for the given example (i.e., west-to-east Buzz Blvd. EB left 

to Burdell Dr. NB), Lane 2 should be selected in from link and 
Lane 1 in to link. 

step vi. Change the Spline value, i.e., the number of points in the spline. 
Generally, use a range from 2 to 4 for a straight connector and 5 to 15 for 
turning connectors. The higher the value, the rounder the turn. Try 5 
points for right turns and 10 points for left turns. You can change this 
attribute later if you are not satisfied with the roundness of the turn.  
Note: This value does not influence vehicle operations; it is simply for 

creating a pleasing network visualization.  



step vii. Keep all the other default settings and click OK. 
 

Figure 6 provides a sample Connector dialog window and visual of the connector. 
 

 
Figure 6: Connector dialog box, EB left at Buzz Blvd. and Burdell Dr. intersection 

Repeat this procedure for EVERY movement of the intersection. There should be a 
total of 8 connectors, allowing for left and right turns from all four approaches. Be 
sure to label all connectors. For this effort, place the right-turn connectors slightly 
further upstream than the left-turn connectors. We will use this placement later in the 
module to facilitate right-turn-on-red (RTOR). Figure 7 shows the final connector 
layout for the Buzz Blvd. and Burdell Dr. intersection. 
 



 
Figure 7: Connector layout for Buzz Blvd. and Burdell Dr. intersection 

Creating Buzz Blvd. / Ramblin St. and Buzz Blvd. / Pi Pkwy. Intersection 
Connectors 

Repeat the procedure for the remaining two intersections. The intersection of Buzz 
Blvd. and Ramblin St. (the center intersection) should have two additional connectors 
to the turning pockets. For each direction of travel, draw a connector from the east–
west road centerline to the upstream end of the turning pocket. This is where vehicles 
will enter the turn bay. The connector for the left turn from the east–west roadway to 
the cross street is then drawn starting at the end of the turn bay. Figure 8 shows the 
connector layout for the full corridor. 
 

 
Figure 8: Corridor connector layout 

 
Save Often! This would be a good place to save your Vissim file. 

  



Helpful Hints – Interface 
 

Overlapping Endpoints 
Sometimes you will be unable to click on the desired link/connector 
endpoint because multiple links/connectors come together and overlap 
one another at the endpoints. To toggle from one link/connector endpoint 
to another, left-click the desired location with the mouse (without holding 
the click) and then press Tab on the keyboard to toggle through the 
overlapping items. 
 

Color Coding 
Connectors are purple and links are blue. If you are trying to draw a 
connector and it shows as blue, you did not successfully connect to an 
existing link but have drawn a new link. Delete the link and try to draw 
the connector again. 
 

Turn-bay Entrance 
Vehicles will only enter the turn bay at the point where the connector 
connects with the turn bay. They will not enter a turn bay partway down 
the turn bay after the connector. Generally, the entrance point to the turn 
bay should capture the longest observed queue in the turn bay (which may 
exceed the “painted” turn bay). 
 

Toggle Link/Connector Labels 
You can toggle off and on the link/connector labels. Right-click on the 
right side of the Network Object – Links icon, and select edit graphic 
parameters. In this table, you can turn off and on labels as well as adjust 
other graphic attributes. 
 

List Current Links and Connectors 
To see a list of all of the links and connectors you created, right-click on 
the right side of the Network Object – Links icon, and select show list. 
This will create the Links/Lanes list window below the Network Editor 
window. Some of the link attributes may be edited from this table. You 
can open similar windows for the other Network Objects; these will be 
very useful as your models become increasingly complicated.  

 

 
 
 
 
 
 
 
 
 
 
 

 
   
 
 
 
  
 
 
 
 
 
  
 
 
 
  



Building the Model, Part 2: Traffic Controllers 
 
Important: This module assumes that the reader has a basic knowledge of intersection 
phasing and signal timing. These concepts are not reviewed in the module.  
 

Introduction 

Adding traffic control devices in Vissim is a two-step process. First, Signal Controllers 
(SCs), Signal Groups (SGs), and timing plans are created. Next, Signal Heads (SHs) are 
placed at the intersections and associated with the appropriate SG and SC. For this module, 
we will use the Vissim Ring Barrier Controller (RBC), which implements dual ring logic. 
We will use the RBC SG (i.e., phase) numbering scheme shown in Figure 9.  
 

 
Figure 9: Dual ring diagram 

 

Setting Signal Controllers and Signal Groups 

In implementing signal timing, an SC is associated with each intersection.  

Note: Similar to the field, a 1-to-1 association between controllers and intersections is 
not required in Vissim. However, such complex control strategies should be 
reserved for more advanced applications and are beyond this module.  

To implement RBC SCs, Vissim utilizes signal groups. Each SC has associated SGs. You 
may think of SGs in Vissim as being synonymous with phases. In the next section of the 
module, an SH in Vissim is then associated with the appropriate SG for a given SC. 

 
For our corridor, we will use permitted-only left turns on all approaches of the westmost 
(Burdell Dr.) and eastmost (Pi Pkwy.) intersections. Thus, these intersections will utilize 
SGs 2, 4, 6, and 8 (see Figure 9). The center intersection (Ramblin St.) will incorporate EB 
and WB protected lefts; thus, this intersection will utilize SGs 1, 2, 4, 5, 6, and 8. 

 



Coding Signal Data 
First, you will define the SC for the intersection of Buzz Blvd. and Burdell Dr. as 
follows: 
 

step i. From the menu bar, select Signal Control and then select Signal 
Controllers. The Signal Controllers window will pop up at the bottom of 
the screen.  

step ii. In the Signal Controllers menu, left-click on the green cross icon  to 
add a controller. The Signal Controller menu will pop up.  
Note: Similarly, you could right-click in the white space on the left side 

of the menu and click add. 
step iii. Beginning with the Buzz Blvd. and Burdell Dr. intersection, assign it the 

No. 111. 
step iv. Change the controller Type from Fixed time to Ring Barrier Controller.  

Note: You may need to scroll to that option. 
step v. For Name, enter “Buzz Blvd and Burdell Dr”. 

 
Next, you will define the SGs associated with the SC as follows: 

 
step vi. Click on Edit signal groups and a new Ring Barrier Controller window 

will pop up. 
 

Helpful Hint  
 

On the RBC pop-up, the tree on the left contains all signal settings, 
advanced options, and patterns used for more complex controllers. Clicking 
on the + or − expands or collapses options, and checking and unchecking 
the boxes will show or hide settings. Take a moment to scan through these 
menus. We will use many of these in a later module where you will learn 
how to incorporate actuation in Vissim. For now, we will simplify the 
timing and utilize max recall to ensure all phases are called. 

 
 

step vii. Check the Base Timings box. 
step viii. Expand Base Timings. 
step ix. The Basic table for the signal controller should display. In the first four 

columns of the first row, SG Number, enter 2, 4, 6, and 8, respectively. 
step x. Insert the signal timing data as shown in Figure 10.  

Note: Be sure to check the Max Recall boxes. The rest of the data in the 
Basic table can remain blank. 

 



 
Figure 10: Basic Timing table parameter values 

for Buzz Blvd. and Burdell Dr. 

step xi. Scroll down to the Sequence table. Arrange the signal group numbers into 
separate rings and form barriers to model the dual ring logic. Enter the 
numbers 2 and 4 in Ring 1, and 6 and 8 in Ring 2 (see Figure 11).  

step xii. To set up the barrier, move the mouse to the area between and directly 
above 2 and 4. Your cursor will turn into “+/-”. Double-clicking will 
add/remove the barrier. 

step xiii. Leave the rest of the Sequence table blank or at the defaults. 
 

 
Figure 11: Sequence table for Buzz Blvd. and Burdell Dr. 

step xiv. Click OK in the Ring Barrier Controller dialog box. 
step xv. When prompted, save the RBC file in your working folder as 

“RBC_Mod1_Buzz_and Burdell_v1” and click OK.  
step xvi. Close the Signal Control window by clicking OK. 

 
For this module, you have generated a simple timing plan, providing each phase with 
a maximum green and placing all phases in Max Recall. This will result in the signal 
operating in a pretimed fashion, serving the max green on each phase, every cycle. In 



Module 2 you will see how to insert actuation and run the signals in free operation on 
coordination. 
 
Repeat the same procedures for the intersection of Buzz Blvd. and Pi Pkwy., using the 
same timing values.  

• Number the intersection 333.  
• Save the file as “RBC_Mod1_Buzz_and Pi_v1”. 

Repeat the procedure again for the intersection of Buzz Blvd. and Ramblin St., noting 
the following:  

• Number the intersection 222.  
• For this intersection, you will also include SGs 1 and 5.  
• Similar to the other intersections, place the barrier after 2 and 6 (by default a 

barrier is also placed after 4 and 8, the last phases listed in each ring).  
• Save the file as “RBC_Mod1_Buzz_and Ramblin_v1”.  

The RBC timing information for Buzz Blvd. and Ramblin St. is shown in Figure 12. 
 

 
Figure 12: RBC controller for Buzz Blvd. and Ramblin St. 



Save Often! This would be a good place to save your Vissim file. 

 
 

CRITICAL CONCEPT 
 

When you save an intersection RBC, it is saved as a separate file from the 
Vissim file. Vissim is linking to that file. If you save your Vissim file under a 
new name, the new Vissim file continues to link to the same RBC file. If you 
wish to update the signal timing, while allowing the original Vissim file to 
retain its current timing, you must save the RBC under a new name and link the 
new Vissim file to the new RBC file.  
 

Example 
Say you create a Vissim file “Base_Case.inpx”. In that Vissim model, 
you create an RBC for an intersection and name it “Int_1_Base.rbc”. 
Now you want to work on your build scenario, so you save the existing 
“Base_Case.inpx” as “Build.inpx” and make changes to the model. If 
you change the timing in the RBC file without changing the RBC name, 
then “Int_1_Base.rbc” will have the build condition timing parameters. 
If you run the “Base_Case.inp”, the timings for intersection 1 will now 
be the build parameters! 

 

There are reasons for this setup—some good and some not—but that is not 
important for now. The critical aspect is to understand the linkage between the 
Vissim file and the RBC files and to avoid making a significant mistake when 
you start working with modeling multiple design alternatives of a corridor. 

 

 

Placing Signal Heads 

After defining the signal controller characteristics, you can now place the signal heads at 
the intersections: 
 

step i. Return to the Network Editor window.  
Note: If you have not already done so, you may close the Signal Controllers 

/ Signal Groups window to increase the Network Editor window size. 
step ii. Zoom in to the Buzz Blvd. and Burdell Dr. intersection. 

step iii. Left-click the Signal Heads icon  in Network 
Objects. 

step iv. Left-click a link to select it (i.e., select the Buzz Blvd EB link). 



step v. Place the signal head on the link by right-clicking at the desired location on 
the link. Note the following: 

• The SH is placed at the stop bar location, not on the intersection far 
side as an in-field signal head.  

• Place the SH in the left lane.  
Note: Each lane will need an SH.  

• The Signal Head data window will pop up. Figure 13 shows the Signal 
Head pop-up window and the SH placed on the lane. 

step vi. Assign a number (the default is okay) and a descriptive name (“Buzz and 
Burdell, EB, Lane 2”) to the signal head. 
Note: These are specific to each signal head in each lane.  

step vii. In the Link - lane field, assign the link and lane number that the signal head 
is controlling.  
Note: Vissim will show default values, i.e., the first in the pull-down list, but 

you must update the selection to the correct values. 
step viii. Assign to the SC - Signal group field the signal controller and signal group 

associated with the intersection and lane movement. Recall, you set the SC 
for the Buzz Blvd. and Burdell Dr. intersection as 111. The SG will follow 
the dual ring number given in Figure 9. Thus, for the EB through lane use, the 
SG is 2.  
Note: For now, a shared lane will receive the through movement SG, 

although more advanced models may utilize more than one signal 
head in a lane.  

IMPORTANT: YOU MUST SELECT THE CORRECT SC - Signal group; 
VISSIM WILL NOT DEFAULT THIS CORRECTLY! 

step ix. Left-click OK.  
 



 
Figure 13: Signal head placement and pop-up window 

 
Helpful Hints 

 

Naming Convention 
Vissim does not impose an SH naming convention, but it is helpful to develop a 
naming convention that eases model debugging and review. For example, for the 
EB signal head placed above, we used “Buzz and Burdell, EB, Lane 2”.  
 

Numbering System 
Unless you prefer to develop a numbering system, the Vissim default number in 
the No. field is fine. If you develop a system, however, you cannot use the same 
number for multiple intersections.  
 

Link Information 
If you do not recall the link number, Vissim 11 will show it when you click on 
the link. For earlier versions, you can double left-click on the link for the link’s 
dialog box. Also, if the Quick View window is open, left-click a link to see the 
link information. You can also toggle on the link labels when setting up an SH.  
 

SH Removal 
If you incorrectly place an SH and wish to delete it, select the SH and drag it to a 
point on the map with no links, or press the delete key on the keyboard. 

 

EB - Left Lane 
Signal Head 



Repeat this procedure for every signalized lane at all three intersections. There should be a 
total of 20 signal heads (6 on the intersection of Buzz Blvd. and Pi Pkwy. and 8 on the 
intersection of Buzz Blvd. and Ramblin St.). Signal heads in adjacent lanes in a multilane 
link should be approximately aligned. (See Figure 14 for example signal head placement 
locations.)  
 
For this module, we are treating the EB and WB left turns to Ramblin St. as protected only. 
However, if you wish to use protected-plus-permitted phasing, then in the Signal Heads 
pop-up window under Or signal group, you would add the SG associated with the given 
left turn, i.e., phase 5 goes with phase 2 and phase 1 goes with phase 6.  
 

Save Often! This would be a good place to save your Vissim file. 
 
 

CRITICAL CONCEPT 
  

When placing an SH, it will only apply to those vehicles on the associated 
link and lane. That is, if an SH is placed downstream of a link-connector 
join location, the vehicles that utilize that connector will not be influenced 
by the SH. This is true even though on the Vissim network map it may look 
as if the SH is covering the connector. When reviewing a model, it is 
sometimes seen that turning movements appear to ignore the SH. This 
typically is due to a signal head being placed downstream (often very 
slightly) of the connector join location on the link. Similarly, an SH may be 
placed on a connector; in such a case, that signal will not influence vehicles 
that remain on the link. 

 
 
Figure 14, showing the Buzz Blvd. and Burdell Dr. intersection SH placements, illustrates 
that the right-lane mainline signal heads are placed just downstream of the right-turn 
connector. This will result in right-turn vehicles not following the signal and enable right-
on-red behavior, to be discussed in the next section. Figure 15 shows the SH placement for 
the Ramblin St. and Pi Pkwy. intersections with Buzz Blvd.  

Note: You may find it easiest to place the SH upstream of the right-turn connector and 
then drag it to the desired place. Just be sure not to drag it onto the connector! 

 



 
Figure 14: SH placement for the Buzz Blvd. and Burdell Dr. intersection 

 

 
Figure 15: SH placement for the Ramblin St. and Pi Pkwy. intersections with Buzz Blvd. 

 

Setting up for Right-Turn-on-Red 

For those right turns where it is desired to allow right-turn-on-red, the through link SH is 
placed downstream of the right-turn connector, as described in the previous section. To 
implement RTOR, Vissim utilizes stop signs, with the signs set to only be active during 
the RED indication of the phase. Thus, right-turning vehicles will flow freely during the 
associated GREEN and YELLOW through indications. The right-turn connector does not 
need a separate SH. The following steps implement the stop sign: 
 

step i. Click the Stop Signs icon . 
step ii. Left-click on the right-turn connector.  

Note: Start with Buzz and Burdell EB right. 
step iii. Right-click at the location where the vehicles will stop to make the right-turn-

on-red movement, and the Stop Sign pop-up window will appear (see 
Figure 16). 

step iv. In Connected to SC - signal group, assign the proper signal group to the stop 
sign. For the EB right at Buzz Blvd. and Burdell Dr., this would be 
intersection 111 and SG 2, i.e., “111 - 2”. 

step v. Give the stop sign a name related to its position, e.g., “Buzz and Burdell EB”  



step vi. Repeat steps i through v for the remaining right turns in the network. 
 

 
Figure 16: Stop Sign pop-up window 

 

CRITICAL CONCEPT 
 

There are several right-turn control configurations:  
• A dedicated right-turn lane would be handled as above.  
• A free-flow (channelized) right turn would have neither an SH or stop 

sign, with the merge onto the receiving lane (i.e., YIELD sign) handled 
using conflict zones, which are discussed later in this module.  

• A right-turn lane overlap (i.e., the right turn has a green arrow but not a 
dedicated phase assignment) would be handled with Vissim overlap 
logic; refer to the Vissim manual for this procedure.  

 
 

 

Save Often! This would be a good place to save your Vissim file. 



Building the Model, Part 3: Traffic Volume and Routing 
Decisions 
 

Setting Traffic Volume 

Traffic enters Vissim models on the boundary links, i.e., the links on the edge of the model. 
Remember that links are directional, so the entry point is the upstream end of a link. In this 
module example, almost all links are boundary links; only the left-turn bay links at the 
intersection of Buzz Blvd. and Ramblin St. are not. However, in a more complicated model, 
there would likely be many internal links on which volumes do not enter the model. In 
addition, there are other means for traffic to enter a model; however, we will not worry 
about those at this time. Input the traffic volume as follows: 

 

step i. Left-click the “Vehicle Inputs” icon  . 
step ii. Left-click a link to activate it, and then right-click on the link to insert a 

vehicle input.  
Example: Left-click the EB mainline link. A black line will appear at 

the start of the link (see Figure 17), and the Vehicle Inputs chart (see 
Figure 18) will appear under the Network Editor window. 

step iii. In the input chart (left chart), enter a name (e.g., “Buzz Blvd, EB inp”), 
number (use default if desired), and volume for each section of the roadway. 
For our example, use 300 veh/hr for north/south entry volumes and 600 veh/hr 
for east/west entry volumes. 

step iv. Keep all other default settings. 
step v. Repeat steps i through v for all volume entry links. 

 
Figure 19 shows the completed Vehicle Inputs table. 

 
 

 

 

 

 

Figure 17: Volume input point 

 

Volume Input 
point 



 
Figure 18: Vehicle Inputs window 

 

 
Figure 19: Complete Vehicle Inputs table 

 
 

Helpful Hints 
 

If you select a row (i.e., left-click the leftmost cell of the row) in the Vehicle 
Inputs table, the associated vehicle input will display as bold on the map. 
Likewise, selecting a vehicle input bar on the map will highlight the associated 
row in the Vehicle Inputs table. 

 
 

 
Save Often! This would be a good place to save your Vissim file.  



 

CRITICAL CONCEPTS – Flow Rate vs. Volume 
 

When entering volume, you are entering flow rates, that is, the 1-hour equivalent 
volume. Thus, if you enter an entry value of 500 vehs for a link but run the 
simulation for 5400 seconds (i.e., 1.5 hours) then a total volume of 750 vehs 
will enter.  
 

In the volume inputs for the module, we have set the entry flow rates to a 
constant value throughout the simulation duration. However, it is possible 
within Vissim to subdivide a run into time intervals and set different flow rates 
within each interval—for instance, you may want to input 15-minute flow rates 
to better reflect the variability in traffic. Time intervals are set in the Base Data 
→ Time Intervals menu. Additional details can be found in the Vissim manual.  

Note: Again, inputs would be flow rates (hourly equivalent volumes) when 
entering interval volume data. 
 
 

Assigning Routing Decisions 

To assign a vehicle to turn left, turn right, or travel straight through an intersection, it is 
necessary to set up routing decisions. For this module, we will assign routing decisions at 
the approach level, similar to the type of data you might have from the intersection turning-
movement counts. 
 
To create routing decisions, you need to define the allowed movements (or routes) for each 
link entering an intersection. For instance, for the EB approach on Buzz Blvd. and Burdell 
Dr., the right, left, and through movements are allowed. The procedure to create routes is 
as follows: 
 

step i. Left-click the Vehicle Routes icon  . 
step ii. Left-click a link that enters an intersection. Start with the EB approach on 

Buzz Blvd. and Burdell Dr. 
step iii. Right-click a point inside the link approximately 200 ft from the intersection 

(see Figure 20). A bar will appear at that location on the link; this is your 
routing decision starting point.  

 



 
Figure 20: Routing decision start 

 
CRITICAL CONCEPT 

 

When placing the starting point of the routing decision, it must be 
sufficiently upstream of the SH to allow a vehicle adequate time to react to 
the SH after crossing the routing decision. If an adequate distance is not 
provided, vehicles will ignore the SH and drive through the red. 
 

 
step iv. Define one of the possible routing destinations, starting with the through 

route, as follows. 
• Move the mouse 50 ft past the intersection on the path that would be 

traversed by a through vehicle; this will drag a blue line to that point.  
• Left-click at that end location. You will see the blue bar at the decision 

endpoint and the path will be highlighted in yellow (see Figure 21). 
 

 
Figure 21: Through vehicle route 

step v. Define the left-turn routing destination, as follows: 
• Move the mouse to a point 50 ft past the intersection on the path that 

would be traversed by a left-turning vehicle.  
• Left-click at that end location. You should again see the path 

highlighted in yellow (see Figure 22). 
 



 
Figure 22: Left-turn vehicle route 

step vi. Define the right-turn routing destination, as follows: 
• Move the mouse to a point 50 ft past the intersection on the path that 

would be traversed by a right-turning vehicle.  
• Left-click at that end location. You should again see the path 

highlighted in yellow (see Figure 23). 
 

 
Figure 23: Right-turn vehicle route 

step vii. Left-click on the map screen anywhere that is not a link or connector (the 
mouse pointer will become an ×). The Static Vehicle Routing Decisions box 
should appear at the bottom of your screen (see Figure 24). The left-hand side 
of the box lists all the routing decision starting points that have been created 
(at the moment there should be just one) and the right-hand side lists all of the 
destination points associated with the starting point selected in the left-hand 
box.  
Note: If you click on a route in the right-hand box, it will be highlighted on 

the map. 
step viii. Fill in Name for the routing decision starting point and destination points, for 

example, “Buzz and Burdell, EB App”, and “RT”, “Thru”, and “LT”.  
Note: The name for the starting point will carry over to the destination 

points, so it is not necessary to repeat the intersection approach name. 
 



 
Figure 24: Static Vehicle Routing Decisions 

 
There are now three routes (left, straight, and right) associated with the EB routing decision 
just created. When crossing a routing decision starting point, Vissim randomly assigns 
vehicles to one of the route destinations according to the relative flows, i.e., with the 
likelihood proportional to the demand assigned to each destination point. The Vissim 
default is equal percentages of vehicles assigned to each destination. The relative flows 
need to be updated for your given scenario. 
 
 

CRITICAL CONCEPT 
 

You may enter relative flows equal to your intersection count data; 
however, this is not required in Vissim. The values in the relative flows will 
be converted to proportions. Thus, the Vissim default of using a “1” for the 
relative flow of each route in our example is converted to a 33.3% likelihood 
that an arriving vehicle will take each path. If you use your intersection 
count values, Vissim does not ensure that the total arrivals sum to the input 
movement total; it simply assigns any vehicles that arrive according to the 
given proportions. Thus, using the intersection count absolute values does 
not guarantee that number of vehicles will be processed, only that arriving 
vehicles will be processed according to the given proportions.  

 
 
For example, assume for the EB approach at the Buzz Blvd. and Burdell Dr. intersection 
that the turning movement counts are 75 left, 375 through, and 150 right. This would result 
in turning percentages of 12.5% left, 62.5% through, and 25% right. In Vissim, entering 



any of the following tuples {75, 375, 150}, {12.5, 62.5, 25}, or {0.125, 0.625, 0.25} in the 
relative flow data will result in the same assignment of vehicles on the approach.  
 
Now, enter flow data for the routing decision as follows: 
 

step ix. Select the routing decisions in the left box by clicking on the routing decision 
row.  
Note: To open the Static Vehicle Routing Decisions window—if it is not 

currently open—right-click on Vehicle Routes in the Network Objects 
menu, and select Show List. 

step x. Insert the relative flow for each route in the RelFlow column in the right box. 
For the EB traffic, use 75 left, 375 through, and 150 right.  
Note: Be sure you are assigning the flow to the correct movement. 

Movements will be listed in the order created. (If you click on a row 
in the right-hand box, the route path will be highlighted on the map.)  

step xi. When you are ready to assign your next set of routing decisions, left-click on 
the map away from any links or connectors.  

step xii. Repeat this process for every approach on all three intersections, entry, and 
internal approaches. Use the volumes provided in Table 1. For Buzz Blvd. 
and Ramblin St. EB and WB traffic, the routing decisions must be placed 
upstream of the turn-bay entrance, and the left-turn routing decision should 
follow the left-turn bay (see Figure 25). There is no need to carry the routing 
decision to the side street, as a vehicle in the turn bay has only one possible 
path; however, you may carry the routing decision through the intersection, if 
desired.  

 
Table 1: Intersection volume counts 

   EB     WB     NB     SB   
  LT Thru RT LT Thru RT LT Thru RT LT Thru RT 

Buzz Blvd. and 
Burdell Dr. 75 375 150 25 300 25 25 150 50 25 200 25 

Buzz Blvd. and 
Ramblin St. 25 350 75 50 300 25 25 50 25 25 50 25 

Buzz Blvd. and 
Pi Pkwy.  25 350 25 25 275 50 50 50 25 25 250 50 

 



 
Figure 25: Buzz Blvd. and Ramblin St. left-turn route 

 
Save Often! This would be a good place to save your Vissim file. 

 
 

Discussion About Routing Decisions 
 

Routing decisions are critical to the implementation of a reasonable model and there are 
several potential pitfalls. A few items to keep in mind when setting routing decisions 
include the following: 
 

1. While a vehicle is on a routing decision, it will ignore all other routing decision 
starting points it crosses until it passes the endpoint of its current decision.  
 

2. Similarly, only vehicles not currently on a route will observe a routing start point. 
Should there be overlapping routes, the modeler needs to exercise caution to be 
sure the model is capturing the desired overall system behaviors (e.g., turning-
movement ratios).  
 

3. The position of the routing decision starting point is the earliest point at which a 
vehicle may begin pre-positioning for a downstream route destination. Where 
vehicles need more time to pre-position into the correct lane (i.e., a left-turning 
vehicle needs to get into the left-most lane), consider moving routing decision 
start points further upstream. Fine-tuning routing decision start points can be a 
critical step in getting the Vissim-simulated vehicles to behave like field 
observations or behavioral expectations. There are no hard-set rules on where to 
place these starting points, instead it requires trial and error fine-tuning by the 
model builder (i.e., you!). 
 



4. While we limited the route path to traversing a single intersection in the module, 
this is not a necessary constraint. Routing decisions can provide significant 
control over vehicle movements. A routing decision may cross many links and 
connectors (i.e., a single routing decision may traverse many intersections), 
creating complex paths through a network. We can quickly see how more 
complex routing decisions could improve the modeling of interchanges, closely 
spaced intersections, etc.  
 

5. When crossing a routing decision starting point, Vissim randomly assigns 
vehicles to one of the route destinations, with the likelihood proportional to the 
demand assigned to each destination point. Typically, this will result in 
acceptable behavior but can create unrealistic vehicle paths, particularly in a grid 
network. That is, a vehicle may be randomly selected as a turning movement at 
multiple points and “drive around the block.” Should such behaviors become an 
issue, more complex multi-intersection routes may provide a solution, as well as 
utilizing vehicle types (not discussed in the module). 
 

6. It is critical to understand that Vissim is only concerned with proportional 
volumes and not absolute volumes when assigning vehicles to paths. Vissim will 
not consider it an error if the total volume count does not sum up to the volumes 
entered in the relative flow. It is up to the modeler to check the absolute volumes 
and determine if there is an error in the model (e.g., an unexpected upstream 
bottleneck).  
 

7. Finally, rather than manually assigning routes, it is also possible to use Vissim 
origin–destination assignment. This is typically reserved for large networks and 
is beyond the scope of this module. 

 
 



 
CRITICAL CONCEPT – Vehicle Speed 

 

Thus far we have not considered vehicle speeds. In Vissim, desired speed is a 
vehicle characteristic rather than a link characteristic. To see this, we first look 
at the Vehicle Inputs in Figure 19. In the last column we see VehComp(0), which 
stands for the Vehicle Composition. It is currently set to Default. To see the 
default Vehicle Composition, go to Traffic → Vehicle Compositions. There is 
currently only one Vehicle Composition, the Default. Select the Default Vehicle 
Composition in the left window. In the right window you will see the vehicle 
types in the composition (Car and HGV) and desired speed for each vehicle type 
(DesSpeedDistr, the speed the vehicles will try to maintain). Currently, the 
desired speed is set to 50 km/h (30 mph). We will use this as the speed for the 
arterial.  
Note: If you wish to change it, select the DesSpeedDistr input and select a 

new value.  
Strictly speaking, the desired speed will be drawn from a distribution, so there 
will be some variability in the desired speed among vehicles. Additional 
discussion on using desired speed, altering the underlying distribution, etc., will 
be provided in Module 5. Vehicle composition, vehicle types, and vehicle 
classes will also be discussed in detail in Module 5. 

 

  



Building the Model, Part 4: Conflict Areas 
 

To avoid collisions at conflict or merge points at an intersection not controlled by a traffic 
signal, it is necessary to set up conflict areas. At each conflict or merge point, it is necessary 
to define the right of way among the permitted movements:  
 

step i. Left-click the Conflict Areas icon  . This will 
result in all possible conflict areas being highlighted. When a conflict area is 
undefined, both approaches will be highlighted yellow. Figure 26 shows the Buzz 
Blvd. and Burdell Dr. intersection. 

step ii. Right-click on the color bars to the right of the Conflict Areas icon, and select 
Show List. 

 
At signalized intersections, conflict areas only need to be defined for movements that could 
conflict during the same green phases. For instance, it is not necessary to define the conflict 
area for the SB left with the EB through, as the signal prohibits this conflict. Scrolling over the 
conflicts with your mouse pointer will outline each conflict area.  

Note: If you are having trouble separating the conflict area, click on the row of a conflict in 
the Conflict Area table to highlight the conflicts in the network map, or use the down 
arrow to scroll through the conflicts. 

 

 

Figure 26: Conflict areas before defining right of way 

step iii. Left-click on one of the two conflicting movements of the conflict area you wish 
to define. Figure 27(a) highlights the Buzz Blvd. and Burdell Dr. intersection EB 
through conflict with the WB left.  



step iv. Right-click on the highlighted conflict until the zone is correctly defined; the 
movement highlighted as green will have the right of way and the movement 
highlighted as red will yield. Figure 27(b) shows the EB through with priority 
over the WB left.  
Note: If you define an area you did not intend to define, continue right-clicking 

until both movements return to yellow. 
 

      
(a)                                                       (b) 

Figure 27: Buzz Blvd. and Burdell Dr. EB through with WB left: (a) conflict 
area highlighted, and (b) conflict movement priorities 

step v. Select and define the remaining conflicts for the Buzz Blvd. and Burdell Dr. 
intersection. You need to define a total of 10 conflict areas, as follows: 

• Four crossing conflicts, one for each of the left turns conflicting with 
opposing through movements, which give the through movements 
priority.  

• Two merging conflicts, one for each left-turn and opposing right-turn 
movement entering into the same lane of the NB and SB receiving lanes, 
which give the right-turn movements priority.  
Note: There is not a conflict on the EB and WB approaches, as the left 

and right turns are received by different lanes. 
• Four merging conflicts, one for each through movement with the merging 

right turn on red, which give the through movements priority. 
Note: All other conflict points will still be highlighted in yellow while the conflict 

area icon is selected, as in Figure 28(a), and will disappear once it is 
deselected, as in Figure 28(b). 

step vi. Define the conflict areas for the intersection of Buzz Blvd. and Pi Pkwy. It has 
the same conflicts as Buzz Blvd. and Burdell Dr. (see step v).  



step vii. Define the conflicts for Buzz Blvd. and Ramblin St. The conflicts are the same as 
in the other intersections except that the EB and WB lefts no longer conflict with 
the opposing through movements, as these are now protected-only movements. 
Note: If we had set these as protected plus permitted, then the conflict areas 

would still need to be defined.  
Also, as the EB and WB lefts are protected, the merge with the RTOR should 
now give priority to the left. The center intersection should have eight conflicts, 
as shown in Figure 29. 

 

     
(a)                                                                        (b) 

Figure 28: Buzz Blvd. and Burdell Dr. conflict areas defined: (a) with undefined conflicts, 
and (b) without undefined conflicts 

 

  
Figure 29: Buzz Blvd. and Ramblin St. conflict areas 



Congratulations!!! 
You have constructed a Vissim model! 

In the remaining two sections you will set up data collection and run your model.  



Building the Model, Part 5: Creating Output Files 
 

Once the network is created, the simulation can be run; however, the simulation will only 
provide a visual representation of the system unless outputs are specified. Vissim can provide 
information on travel times, delays, queue lengths, green time distribution, specific vehicle 
information, etc. We will create output files that provide the delay measures. 

 

Setting Evaluation Criteria 

First, we need to set the evaluation criteria:  
 

step i. In the main menu bar, click on Evaluation → Configuration. The Evaluation 
Configuration pop-up box should appear (see Figure 30). 

step ii. Select the Result Attributes tab if it is not already selected. The Result 
Attributes tab creates the display of results in list windows (typically a 
window under the Network Editor window) for the respective attributes.  
Note: The generated files may also be opened post analysis, e.g., using Excel 

or SQL.  
step iii. In the lower box, you should see the potential measures listed. For Delays 

click the Collect Data box and fill in the values with a From-time (i.e., start 
time) of 900, To-time (i.e., end time) of 4500, and an Interval of 900. This 
will give us 1 hour of simulation data, starting at time = 900 seconds. Data 
will be output for the entire hour as well as each of the 15-minute 
(900-second) intervals.  

 
 

CRITICAL CONCEPT 
 

As the model starts, the beginning of the simulation has no vehicles. 
Typically, we want to wait some amount of startup time for the model to 
“fill.” Data collected before this point would not be representative of desired 
conditions, likely providing biased performance measures such as low 
delays and travel times. We will go into a model startup in much more detail 
in the Model Calibration module; however, for now, we will just use a 
15-minute warm-up period. 

 



 
Figure 30: Evaluation Configuration pop-up window, Result Attributes tab 

 
step iv. Click on the Direct Output tab (see Figure 31). In the Direct Output tab, you 

designate results you would like to have written to a file. 
step v. In the Write to file column, select Vehicle record and Vehicle travel times 

(raw data). 
step vi. For Vehicle record and Vehicle travel times (raw data), set the From-time and 

To-time attributes to 900 and 4500, respectively. 
 



 
Figure 31: Evaluation Configuration pop-up window, Direct Output tab 

 
step vii. Click on the Result Management tab (see Figure 32).  
step viii. Under Keep result attributes of previous simulation runs, select of current 

(multi-)run only.  
Note: Keeping the result attributes of only the current run will overwrite any 

output files of previous simulation runs with the most recent run.  
step ix. Make note of the output file destination given in Evaluation output directory 

at the top of the window.  
Note: If you do not want to use the default, change the directory to your 

preferred location.  
step x. Select OK. 

 



 
Figure 32: Evaluation Configuration pop-up window, Result Management tab 

 

Creating Travel Time Segments  

In order for Vissim to collect travel times, delays, and other vehicle data, you will need to 
add travel time segments, as follows:  
 

step i. Left-click the Vehicle Travel Times icon  in the 
Network Objects list on the left side of the Vissim window. 

step ii. Left-click on the desired link of the starting position. We will put a travel time 
segment on the mainline EB link (see Figure 33).  

step iii. Right-click to select the desired start location. The start location will be shown 
with a red bar.  
Note: Select a couple hundred feet downstream of the EB entrance. 

step iv. Right-click to select the desired end location. The end location will be shown 
with a green bar.  
Note: Select a couple hundred feet after the Buzz Blvd. and Pi Pkwy. 

step v. The Travel Time Measurement pop-up window should appear. Add a name 
for your travel time segment (see Figure 34).  

step vi. Select OK. 



 
 
 
 
 

 
Figure 33: Buzz Blvd. EB, end-to-end travel time segment 

 

 
Figure 34: Travel Time Measurement pop-up window 

step vii. Using the procedure above, set seven more travel time segments, as follows: 
• WB end-to-end on Buzz Blvd. (i.e., the main E–W street). 
• NB on the intersection of Buzz Blvd. and Ramblin St. 

Note: Again, start a couple hundred from the model entrance and 
end a couple hundred after the intersection.  

• SB on the intersection of Buzz Blvd. and Ramblin St.  
• EB for only Buzz Blvd. and Ramblin St. 

Note: Start on Buzz Blvd. EB approximately a hundred feet past 
Burdell Dr. and end a couple of hundred feet after Ramblin St.  

• WB for only Buzz Blvd. and Ramblin St. 
Note: Start on Buzz Blvd. WB approximately a hundred feet past Pi 

Pkwy. and end a couple of hundred feet after Ramblin St. 
• EB left at Buzz Blvd. and Ramblin St. 

Note: Start on Buzz Blvd. EB approximately a hundred feet past 
Burdell Dr. and end a couple of hundred feet after the 
intersection on Ramblin St. NB (i.e., the receiving lane). 

Travel Time 
Segment Start 

Travel Time 
Segment End 



• WB left at Buzz Blvd. and Ramblin St. 
Note: Start on Buzz Blvd. EB approximately a hundred feet past Pi 

Pkwy. and end a couple of hundred feet after the intersection 
on Ramblin St. SB (i.e., the receiving lane). 

 

Creating Delay Measurements 

Next, you will create delay measurements for the travel time segments, as follows:  
 

step i. In the main menu at the top of the screen, left-click Lists → Measurements → 
Delay Measurements. 

step ii. Left-click the green cross in the Delay Measurements pop-up window menu.  
step iii. Name the measurement after the direction of travel, starting with “Buzz Blvd. 

EB, End-to-End”. 
step iv. Select the box in the VehTravTmMeas column, select the pull-down arrow, 

and assign the correct travel time segment.  
step v. Repeat the procedure for the other travel time segments. Figure 35 shows the 

completed travel times. 
Note: The order of your list may be different, depending on the order in 

which you set it up. 
 

 
Helpful Hints 

 

You may need to go back to the list of travel time segments if you cannot 
remember them. You can do this by right-clicking on the Vehicle Travel Time 
icon in the Network Objects toolbar and selecting Show List. You can now 
flip between the Travel Time Segment list and the Delay Measurements list 
by selecting the associated window tab at the bottom of the Vissim window.  

 
 

 
Figure 35: Delay Measurements list 



 

Creating Delay Results 

As a final step, you will select which delay results you want to display and send to the 
output files, as follows:  
 

step i. In the main Vissim menu, click Lists → Results → Delay Results. 

step ii. Click on the Attribute Selection (wrench) icon  in the Delay Results pop-
up window. The pre-set attribute list will collect data such as stops and stop 
delay for all six vehicle classes. The Vissim default composition is for all 
vehicles to be class 10 (i.e., cars). You can add and eliminate attributes using 
the horizontal arrows (see Figure 36).  

step iii. Set your list to be the same as in Figure 36. As the model runs, you will be 
able to see the delay results in the Delay Results list window. 

 

 
Figure 36: Delay Results: Select Attributes screen 

step iv. Click OK, and then ensure the sigma  and floppy disk with red arrow  
icons are selected (see Figure 37).  
Note: The plain floppy disk button cannot be pressed until after the 

simulation is run.  



Helpful Hint 
 

Take a few minutes to explore the list on the left side of the Delay Results: 
Selected Attributes pop-up window. Skimming through the list, you can observe 
a significant number of delay measures that you can collect. 

The floppy disk with red arrow icon sets up the delay files to autosave to the 
location you select.  

Note: This location is selected after you run the simulation by pressing on 
the plain floppy disk icon and choosing a path location.  

 

 
Figure 37: Delay Results: Autosave and Simulation Run Aggregate buttons selected 

 
 
 
 
 
 
 
 

 
CRITICAL CONCEPTS 

 

When setting up performance measures, such as delay, using travel time 
segments, the measure is ONLY captured within the travel time segment. 
Thus, if a queue should go past the starting point of the travel time segment, 
any delay experienced beyond this point would not be captured in the 
measure. This is why we set the starting point of a travel time segment as 
far upstream of an approach stop bar as possible. We also set the endpoint 
sufficiently downstream of a stop bar to capture delay due to acceleration 
from a stop. The delays from the end-to-end travel time segment will 
capture the aggregate delay experience at all three intersections. 
 

In addition, measures from travel time segments only reflect vehicles that 
travel the full length of the segment. Thus, if a vehicle only travels on a 
portion of the travel time segment, that vehicle’s metrics will not be 
included in the segment results. 
 

 
All of the measures in this section are dependent on the vehicle speeds. In this module we 
did not adjust the vehicle’s desired speed (i.e., the speed of the vehicle in free-flow 
conditions), but left it at the default value. To see the default desired speed, go to the pull-



down menu Traffic → Vehicle Compositions. The Vehicle Compositions list will open 
under the Network Editor. For the default setting, both the car and heavy vehicle are set to 
50 km/hr (31 mph). This will be the desired speed for all vehicles as they enter the model. 
For our arterial example, this speed is fine. In Module 4 we will see how to change the 
desired speed for different segments of the network, e.g., to have a higher desired speed on 
the freeway.  

Note: Vissim actually uses a distribution for desired speed. For instance, for 50 km/hr, 
each vehicle will have a randomly selected value between 50 km/hr and 55 km/hr. 
We will discuss how to set these ranges in Module 5.  



Building the Model, Part 6: Running the Simulation 
 

To run the simulation, we must first set the simulation run length. Then we will run the 
simulation and review the collected performance measures. 
 

Setting Final Parameters 

step i. In the main menu bar, click Simulation → Parameters. 
step ii. Set the simulation Period to 4500 seconds. 
step iii. Set the Start time to 00:00:00. 
step iv. Set the Simulation speed to Maximum. 
step v. Click OK. 

 

Running the Simulation 

step i. Run the simulation by clicking the Run icon . Cars should start going through 
the intersection. 
• You can toggle between the wireframe and roadway view by clicking on  

or pressing Ctrl+A on the keyboard.  

• You can toggle between 2D and 3D views by clicking the 3D Toggle icon  
or pressing Ctrl+D on the keyboard. The × over the icon means that 3D is 
turned off. Clicking the icon switches the view to 3D and removes the ×.  
Note: Switching over to 3D will potentially slow the simulation speed, as the 

computer now has to render in 3D. 
• Under View in the main menu, select Simple Network Display if you wish to 

hide the conflict zone, travel time segment, etc. graphics that can clutter the 
screen. 

step ii. Wait for the simulation to finish.  

Note: Run time can be sped up by selecting the Quick Mode icon  prior to 
selecting the Run icon. Quick mode turns off the animation. However, for 
now we recommend that you leave animation on, as this is one of the best 
ways to check a model. 

 



Finding and Saving Your Files 

You should see your results in the Delay Results table at the bottom of the Vissim screen. 
The results should look similar to those in Figure 38. 
 
To save the file:  

step i. Click the Floppy Disk icon.  
step ii. Choose a file name and location for the output file.  

Note: Remember that earlier the output files were set to only have data for 
the most recent simulation run. This can be changed in the Evaluation 
Configuration menu. Clicking the autosave will result in saving delay 
results in the location of your choosing. Only click this if you 
understand you will lose the delay outputs for past simulation runs.  

The file will output as an .ATT file, and other raw data will be output as .FZP and .RSR 
files. These may all be opened in Excel or any text editor (such as Notepad). 

 

 
Figure 38 Partial Delay Results table 

Your results may differ slightly from those in Figure 38, as we have not been overly precise 
in the geometry and your evaluation points may be in slightly different locations. You may 
also be using a different random seed (which we will discuss in a later module). 



Helpful Hints 
 

A similar process can be followed to collect travel time information, as follows:  
step i. In the Main Menu, select Evaluation → Configuration, check the box 

for Vehicle Travel Times, and set the From-time, To-time, and Interval 
in the Result Attributes tab.  

step ii. Next, go to the menu Lists → Results → Vehicle Travel Time Results 
and under the attribute list select the types of data you want to collect. 

step iii. After you run the simulation, select the folder in which to save the 
data. 

 
 
 
 
 
 
 
 

  



Helpful Hint 
 

Carefully step through and observe the animation for each component of the 
model and confirm the vehicle behaviors are correct!!! 

 
 

 
CRITICAL CONCEPT 

 

An important question is: “Are my results valid?” In a later module, we will 
provide guidance on calibration and validation. However, do not underestimate 
your ability to evaluate your results for reasonableness. Review your findings; 
if they do not seem reasonable to you, then they probably are not. Carefully 
review the model, watching each part during the run. Too often, modelers try 
to calibrate parameters to fix what is in actuality a modeling error. It is critical 
that you first verify the model is working correctly, i.e., is the model behaving 
as you think it is supposed to behave? For instance, when watching a model 
run: 

• Do vehicles always stop at each red signal head or do they “run the 
light”? If they are running the light, you may have set the routing 
decision point too close to the signal head or have the signal head past 
the connector, or some other setup issue.  

• Is the RTOR behaving as you expected? 
• Are the permissive lefts stopping for the opposing through vehicles? 
• Are all of the signal heads changing as expected? 
• Are vehicles utilizing all of the turning movements? 
• Are any queues building far beyond expectations? 
• Are the volumes being processed in the right “ballpark”? 
• Are the travel times and delays “reasonable”?  
• Etc. 

 
 

You may not know what the delays, travel times, etc. should be exactly—that is why you 
are creating the model! However, you should have a sense of order of magnitude and be 
able to identify likely erroneous results, whether too bad or too good.  

 
In addition, Vissim will provide warning messages at the end of the run. Review the 
messages and try to eliminate all warnings. 
 

 
 

  



 
CONGRATULATIONS!!! 

 

You have completed your 
first VISSIM model!  

 

Way to go!!! 
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